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Vitec Group Communications

SOFTWARE LICENSE

IMPORTANT:  CAREFULLY READ THE FOLLOWING BEFORE 
USING THIS SOFTWARE.  USING THE SOFTWARE INDICATES 
YOUR ACKNOWLEDGMENT THAT YOU HAVE READ THE 
FOLLOWING AND AGREE TO ITS TERMS.  
IF YOU DO NOT AGREE, RETURN THE SOFTWARE COMPLETE 
TO VITEC GROUP COMMUNICATIONS LIMITED OR CANCEL THE 
INSTALLATION.
 THIS IS YOUR PROOF THAT YOU HAVE A VALID LICENSE.  
PLEASE TREAT IT AS VALUABLE PROPERTY.
VITEC GROUP COMMUNICATIONS LIMITED OR VITEC GROUP 
COMMUNICATIONS, INC., as the case may be (hereinafter referred 
to as “VGC”), offers you this storage media containing a 
computer program and files (the “SOFTWARE”) and offers to 
grant to you a non-exclusive  and non-transferable License to use 
the Software on the following terms.  Any new revision or update 
of the Software provided by VGC to Customer under this License 
shall be governed by the terms and conditions of this License.

1. APPLICATION
a. These terms supersede all prior agreements representations 
and understandings between you the Customer and VGC and their 
authorised representatives relating to the subject matter hereof 
(i.e., the Software) but shall otherwise be subject to Vitec Group 
Communications Terms and Conditions, as amended from time to 
time.  For the avoidance of doubt, in the event of conflict, these 
terms shall prevail. 
b. No variation to these terms, nor any other terms or conditions 
proposed by you, shall be of any effect unless recorded in a written 
document signed by VGC. You confirm that any statement made to 
the contrary by you or on your behalf shall not apply to this 
License.
c. You confirm that you are not relying on any statement made by 
or on behalf of VGC, other than statements recorded in a written 
document signed by VGC.
d. VGC and its licensors reserve all rights not expressly granted to 
you.  VGC's licensors are intended third party beneficiaries of this 
Agreement and have the express right to rely upon and directly 
enforce the terms set forth herein.
e. You agree that the Software belongs to VGC and its licensors.  
You agree that you neither own nor hereby acquire any claim or 
right of ownership to the Software or to any related patents, 
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copyrights, trademarks or other intellectual property.  VGC and its 
licensors retain all right, title and interest in and to the Software and 
all copies thereof at all times, regardless of the form or media in or 
on which the original or other copies may subsequently exist.  This 
license is not a sale of the original or any subsequent copy.

2. COPYRIGHT
a. The copyright and all other rights in the Software produced by 
VGC shall remain with VGC or its suppliers.  You must reproduce 
any copyright or other notice marked on the Software on any 
copies that you make. 

3. YOU MAY: 
a. Use the Software only at a single site location.  If you wish to use 
the Software at more than one site you must contact VGC and if 
required purchase further Licenses;
b. Make one copy of the Software for archival or back-up purposes, 
and;
c. Transfer the Software to an end user of a VGC product, only if 
you have made it clear to VGC that you are not the end user and 
you assign all of your rights under this License and make no use of 
the Software yourself. 

4. YOU MAY NOT:
a. Use the Software or make copies of it except as permitted in this 
License;
b. Publish or distribute the computer images, sound files or fonts 
included with the Software as computer images, sound files or 
fonts;
c. Translate, reverse engineer, decompile or disassemble the 
Software, except to the extent the foregoing restriction is expressly 
prohibited by applicable law;
d. Rent, lease, assign or transfer the Software except as set out 
above; or
e. Modify the Software or merge all or any part of the Software in 
another program.

5. TERM:
a. This License shall continue for as long as you use the Software.  
However, it will terminate if you fail to comply with any of its terms 
or conditions.  You agree, upon termination, to destroy all copies of 
the Software.  The Limitations of Warranties and Liability set out 
below shall continue in force even after any termination.

6. LIMITED WARRANTY:
a. VGC warrants that the storage media in this Software will be free 
from defects in materials and workmanship for 90 days from the 
date you acquire it.  If such a defect occurs, return it to us at the 
address below and we will replace it free.  This remedy is your 
exclusive remedy for breach of this warranty.
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b. After the initial 90 days, THE SOFTWARE IS PROVIDED "AS 
IS" WITHOUT WARRANTY OF ANY KIND EITHER EXPRESS, 
IMPLIED OR STATUTORY, INCLUDING BUT NOT LIMITED TO 
THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS 
FOR A PARTICULAR PURPOSE, PERFORMANCE, ACCURACY, 
RELIABILITY, OR NON-INFRINGEMENT OF THIRD-PARTY 
INTELLECTUAL PROPERTY RIGHTS.  This constitutes an 
essential part of this License.

7. LIMITATION OF LIABILITY:
a. For the avoidance of doubt, all conditions imposed by law 
covering matters such as fitness for purpose, compliance to 
description, negligence and quality are expressly excluded from 
this agreement and you agree to accept the foregoing warranty in 
lieu of all such items. 
b. IN NO EVENT SHALL VGC BE LIABLE FOR ANY LOSS OF 
PROFITS, LOSS OF BUSINESS, LOSS OF DATA OR USE OF 
DATA, INTERRUPTION OF BUSINESS, OR FOR INDIRECT, 
SPECIAL, INCIDENTAL, EXEMPLARY, MULTIPLE, PUNITIVE OR 
CONSEQUENTIAL DAMAGES OF ANY KIND, WHETHER 
BASED ON CONTRACT, TORT (INCLUDING WITHOUT 
LIMITATION, NEGLIGENCE), WARRANTY, GUARANTEE OR 
ANY OTHER LEGAL OR EQUITABLE GROUNDS, EVEN IF VGC 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES.  
c. The warranty is personal to you (or end user if you have made it 
clear that you are not the end user) and may not be transferred 
(except as permitted expressly above). 
d. VGC shall not be a liable for failure to perform any obligation to 
you where such failure is due to circumstances beyond VGC’s 
reasonable control.
e. VGC offers extended warranties and, if you are not satisfied 
with the above, you should consider such warranties or 
consider separate insurance. 

8. RESTRICTED RIGHTS:
If this Software is acquired by or for the U.S. Government then it is pro-
vided with Restricted Rights.  Use, duplication, or disclosure by the U.S. 
Government is subject to restrictions as set forth in subparagraph 
(c)(1)(ii) of The Rights in Technical Data and Computer Software clause 
at DFARS 252.227-7013, or subparagraphs (c)(1) and (2) of the Com-
mercial Computer Software - Restricted Rights at 48 CFR 52.227-19, or 
clause 18-52.227-86(d) of the NASA Supplement to the FAR, as appli-
cable.  Contractor/manufacturer: Vitec Group Communications Limited, 
7400 Beach Drive, Cambridge, England CB25 9TP or Vitec Group 
Communications, LLC, 850 Marina Village Parkway, Alameda, CA 
94501.

9. OTHER ISSUES:
a. Any failure by VGC to insist on its strict rights under this 
Agreement shall not be deemed to be a waiver of those (or any 
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other rights) and only a duly executed written release shall 
constitute such a waiver.
b. If any of these conditions is deemed invalid or unenforceable the 
remainder shall be unaffected. 
c. VGC's dealings with you shall be governed by English law if you 
are resident in the EMEA region and California law if you are 
resident elsewhere.  The federal and state courts of California for 
Non-EMEA Customers and English Courts for EMEA Customers 
shall have exclusive jurisdiction to adjudicate any dispute arising 
out of this Agreement.
d. If any document is written in more than one language the 
English text shall prevail.  
e. Capitalized terms not defined herein shall have the meanings 
set forth in Vitec Group Communications' Terms and Conditions, as 
amended from time to time.
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DECTSYNC
ACTIVE ANTENNA SYNCHRONIZATION 
PROCEDURE
This document describes how to eliminate phase differences from 
Active Antenna DECT Sync signals.  Each Active Antenna connected 
to a matrix or base station must have their DECT timeslots 
synchronized. This is achieved by means of a 100Hz sync signal that 
is generated by the E-Que card or base station and transmitted via the 
CAT5 cable, as shown in Figure 1-1.

Figure 1-1: Active Antennas Connected to Base Station or Matrix

If the cable connecting Active Antenna 2 to the splitter is substantially 
longer than the cable connecting Active Antenna 1 to the splitter, then 
the DECT sync signals could be sufficiently out of phase to cause 
handover problems. This is due to the propagation delay of the Sync 
signal through the cable. If the Active Antennas are far enough apart 
(325ft/100m), then this is not a problem, but if they are located quite 
close to each other then it could result in handover difficulties.

Although the DECT sync values are expressed in terms of cable 
length, in fact these parameters actually compensate for the different 
propagation times of each cable - that is the length of time that it takes 
a pulse to travel from one end of the cable to the other. A number of 
factors can affect this. The length of the cable is one of them; others 
might include the impedance of the cable, the characteristics of the 
connectors etc.
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The reason why it is possible to have a zero length in the cable length 
entry is because these parameters, when derived using the DECT 
sync procedure, are offsets rather than absolute values, measured 
relative to one reference cable / antenna. So the antenna that the 
DECT sync procedure uses as its baseline, and any other antennas 
with similar propagation times, will all appear to have a zero cable 
length, as the pulse delay will be the same for all of them.

This also explains why the length parameter can be increased beyond 
the maximum cable length specified in the manual. The physical 
characteristics of the cable may mean that its propagation delay is 
much longer than might be expected from its physical length alone.

The following equipment is required to carry out the Active Antenna 
Synchronization procedure:

1. MK II Beltpack to allow communication with the DECT sub-system, 
as described in the procedure.  Beltpack must have v.17_K19 or 
later of DECT firmware.

2. PC/Laptop/Notebook running DECTSync Application.
3. Serial Cable to connect the beltpack to the laptop.
4. ECS V4.2 or later if using an Eclipse rack.
5. Omega/Median rack code 11.20 or later if using an Eclipse Omega 

or Median rack.
6. E-QUE application code v1.0 or later if using an Eclipse Omega or 

Median rack.

MEASURE ACTIVE ANTENNA SYNCS
The procedure below outlines how to use a beltpack and the 
DECTSync utility to test the active antennas and obtain DECT 
synchronization data to input into ECS or the Configuration Editor.  The 
synchronization data is presented by the DECTSync utility as cable 
lengths as a means of expressing the overall propagation delay.

1. Get a list of all Active Antennae from ECS or the 
CellCom/FreeSpeak Configuration Editor with their port numbers. 

2. Obtain a map of the site and mark the location of each Active 
Antenna. 

3. Set all the antenna cable length values to zero in ECS (Eclipse 
matrix) or the Configuration Editor (Cellcom/FreeSpeak).

4. Download a new map with the antenna cable lengths set to zero to 
the matrix or base station and perform a reset to load the new 
values.

5. Connect a beltpack serial upgrade cable between the laptop's serial 
port and the test Beltpack. If a serial port is not available on the 
laptop, use a USB to serial converter.  The pinout for this cable is 
given in Figure 1-3 on page 1-14 of this manual.
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6. Start the DECTSync program and select the relevant serial/COM 
port. 

7. Switch on the test Beltpack while holding down the right-hand 
scroll/menu key.  The DECT survey mode screen should be 
displayed after the beltpack has connected to the basestation 
(Figure 1-2 below).

Figure 1-2: Beltpack Connection Status Information

Note: If the beltpack does not enter “site survey” mode (for 
example because no serial cable is present) press the right 
front-panel scroll button again with the beltpack still 
switched on.  The beltpack will then be forced into “site 
survey” mode.

8. Beltpack Connected…", should be displayed in the lower left corner 
of the DECTSync window within a few seconds. If "Attempting To 
Connected To Beltpack…" continues being displayed, then switch 
off the Beltpack and start again from step 5. If that fails, check that 
the correct serial port has been selected and that the everything is 
plugged in properly. 

9. Once a connection has been established between the Beltpack and 
DECTSync, the Sync Grid should start being populated, assuming 
that a connection has been established to an Active Antenna. 

10. Walk around the site, ensuring that you connect to every Active 
Antenna where possible. At the very least the number of rows and 
columns in the grid should match the number of Active Antennae on 
site. 

11. Generate a DECTSync report via the Tools->Generate AA Cable 
Length Report… menu. 

Note: If the DECTSync procedure is carried out more than once 
ensure that the site survey is always started from the same 
antenna each time otherwise the cable lengths may differ 
between reports.

12. Update ECS or the Configuration Editor with the Active Antenna 
cable length information. 

13. Download the new map to the matrix or base station and perform a 
reset to load the new values. 

14. Repeat steps 5 to 9, ensuring that all the phases shown in the Sync 
Grid are between -9 and +9 or the effective cable length is 845ft 
(260 meters) or less. 
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DECTSYNC OPERATION
The main DECTSync window displays the relative Active Antenna 
phase grid. In the grid shown below, the Active Antennae detected are 
RPNs (Radio fixed Part Identifier) 24, 25, 26, 27 & 28. The RPN can be 
displayed in Hexadecimal or Decimal, via the Options->RPN Display 
Base menu item. 

Figure 1-3: DECTSync Grid

The values shown in the grid can be in RFPS units, Active Antenna 
Sync units or in Metres and are selected via the Options->Display 
Format menu item. 

RFPS UNITS
The values returned in the DECT module's Radio Fixed PartS report. 
These are the highest resolution units available. Each unit is equal to 
about 29 metres. 

ACTIVE ANTENNA SYNC UNITS
The values used to initialize the Fixed Part DECT module in the Active 
Antenna. An AA Sync unit is equal to a RFPS unit divided by 4.5. Each 
unit is equal to about 130 metres. 

METRES
The effective length of CAT5 cable between the E-QUE Card or Base 
Station or Antenna Splitter and the Active Antenna. Each 130 metre 
step is equal to 4.5 RFPS Units or 1 Active Antenna Sync Unit.

The grid shows relative phase offsets between Active Antennae. Each 
row displays the relative phases of the Active Antennae detected while 
the Beltpack is connected to the Active Antenna with RPN indicated in 
the left hand column. For example, when connected to Active Antenna 
25, Active Antennas 24, 26, 27 & 28 were detected. Active Antenna 25 
is -3 out of phase with respect to Active Antenna 24. This means that 
Active Antenna 24's effective cable length is about 78 metres longer 
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than that of Active Antenna 25. Blank cells indicate that no readings 
have been obtained. Cells are grey where Active Antenna RPNs 
intersect. 

The status bar is displayed at the bottom of the DECTSync window.

Figure 1-4: DECTSync Status Bar

The first panel from the left shows the connection status of the test 
Beltpack. If "Attempting To Connect To Beltpack..." is displayed, then 
DECTSync is waiting for a test Beltpack to be connected to the 
selected serial/COM port. DECTSync must be started before switching 
on the test Beltpack. Once communications have been established 
with the test Beltpack, "Beltpack Connected..." is displayed. The third 
panel shows the number of live RFPS reports received from the 
Beltpack. RFPS have don't have any information regarding 
neighboring Active Antennae are not included in this count. The fourth 
panel displays a count of the number of Active Antennas detected so 
far. The fifth panel displays the COM port currently selected. The sixth 
panel displays the baud rate, which should always be 19200. 

The second panel from the left indicates if the RFPS reports are being 
logged to file or not. Logging can be controlled via the Tools->Log Data 
To File menu. 

The beltpack Site Survey Information Connection screen displays the 
RPN (item 6) of the Active Antenna the test Beltpack is currently 
connected to, as shown below. 
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Figure 1-5: Site Survey Information Screen

A full description of all the fields is given in Table 1-1 below.

Table 1-1: Connection Information

Item Description

1 Radio Fixed Part Identifier. This title refers to the whole of 
the second line of text. The RFP is the Radio Fixed Part to 
which the Beltpack is currently connected. (Much of this line 
of text is not unique to one Active Antenna.)

2 This is the PARK (Primary Access Rights Key) number 
(reserved for future use.)

3 The abbreviation stands for Equipment Installer Code and 
the number on the second line is the EIC number.

4 Fixed Part Number. This and item 6 below are unique to the 
particular Active Antenna.

5 Fixed Part Sub-Number. This is effectively the system 
number which identifies which matrix the Beltpack is 
registered with.

6 Radio Fixed Part Number. This is the identifier of the Active 
Antenna on the system.

7 Carrier Number (both Active Antenna and Beltpack)

8 Timeslot Number (used by Active Antenna)

9 Received Signal strength Indication (digital indication). This 
is an arbitrary number in the range 0-52 and, therefore, 
significant only in the context of a particular installation. 

10 Block error rate for received frames. 
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Active Antenna Synchronization Procedure

1 - 6



MENU ITEMS 

Select COM Port
Select the COM Port that the Beltpack will be connected to. The baud 
rate is always 19200 for a CellCom/FreeSpeak Beltpack. 

Clear Sync Grid & Results
Clear the Sync Grid and all the results collected so far. This option is 
only enabled once a connection to the test Beltpack has been 
established. 

Clear Sync Grid & Force Beltpack Search
Clear the Sync grid and all the results collected so far, then put 
DECTSync in the state where it can detect that a Beltpack has been 
switched on. This option can be used when the Beltpack is 
disconnected from the laptop. This option is only enabled once a 
connection to the test Beltpack has been established. 

Clear Sync Data Log
Clear the log box. This option is only enable if the Display Log option is 
set to on. It does not affect the data that is logged to file. 

Display Log
Select whether to display the raw phase data reported by the Beltpack 
or not. If On is selected, then a text box is displayed in the lower part of 
the main DECTSync window. Sync data points are displayed along 
with timestamps, in the form: 

    16/03/2005 15:05:13, 25->27=4

This reading means that while the test Beltpack was connected to the 
Active Antenna with RPN 25(Decimal), AA with RPN 27 was detected 
with a relative phase of +4. This means that AA 27's effective cable 
length is about 104 metres shorter than AA 25's. These raw readings 
are noisy, so the values displayed in the grid are averaged. 

11 Raw battery level indication.

12 DECTSync survey mode indication.

Note: Due to screen resolution only one ‘S’ may be 
visible.

Table 1-1: Connection Information

Item Description
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Display Format
Select the display format to be used in the main grid. 

RFPS Units
The values returned in the DECT module's Radio Fixed PartS report. 
These are the highest resolution units available. Each unit is equal to 
about 29 metres. These are the units shown in the log. 

Active Antenna Sync Units
The values used to initialize the Fixed Part DECT module in the Active 
Antenna. An AA Sync unit is equal to a RFPS unit divided by five. Each 
unit is equal to about 130 metres. 

Metres
The effective length of CAT5 cable between the E-QUE Card / Antenna 
Splitter and the Active Antenna. Each 130 metre step is equal to 5 
RFPS Units or 1 Active Antenna Sync Units. 

RPN Display Base
Select whether to display the Active Antenna RPN number in 
Hexadecimal or Decimal. The RPN is displayed in decimal in the 
Beltpack's Connection Information screen. 

Display FPS
Select whether to display each Active Antenna's FPS number (1-15) 
along with in RPN in the grid. 

View Debug
Select whether to open a separate window to display the raw RFPS 
reports from the DECT stack. 
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Log Data To File
This option allows all the raw data points reported by the Beltpack to 
logged to an ASCII text file. 

Figure 1-6: DectSync Logfile Dialogue

Click Start to begin logging to the specified file. Logging can now be 
Paused, Resumed or stopped via the Tools->Log Data To File menu. 

Generate AA Cable Length Report
A HTML formatted report is generated, displaying the calculated 
effective Active Antenna cable lengths, which can be entered into ECS 
or the CellCom/FreeSpeak Configuration Editor.  The Active Antenna 
relative Sync results grid is also included in the report. 

The window shown below is displayed, allowing various details to be 
entered as well as the filename. The site name, tester’s name and 
miscellaneous notes are included in the report. If the “Show Report” 
box is checked, then the report is automatically displayed in the default 
web browser. 

Figure 1-7: Report Generator
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Converter
Selecting this option opens the window shown below. 

Figure 1-8: Unit Converter Screen

To convert between the various units, simply enter the value and press 
enter or click the relevant update button. 

DECTSYNC INSTALLATION
To install the DECTSync program:

Navigate to the DECTSync folder under “3rd_Party_Software\Wireless 
System PC Tools\DECT\DectSync v1.1.0’ on the Eclipse system 
software distribution CD (part no. 750013Z) or ‘Firmware\PC 
Tools\dect\Dect_Sync\DectSync v1.1.0’ on the CellCom system CD 
(part no. STA0410CC) or the FreeSpeak system CD (part no. 
STA0410FS).

Run the file ‘Setup.exe’ in the folder to start the installation.  The 
DECTSync setup screen is displayed.
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Figure 1-9: DECTSync Installation Setup Screen

Use the ‘Change Directory’ button to browse to a different directory to 
the default if required.  It is recommended that the default directory is 
accepted.

Click on the Install button to start the installation.  The installer will 
check the available disk space.
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Figure 1-10: DECTSync Setup

If sufficient disk space is available (around 700K) the installer will 
display a list of available program groups.  This is the program group 
DECTSync will be placed in under the ‘Programs’ menu.

Figure 1-11: Select Program Group

It is recommended that the Clear-Com group is selected if it already 
exists.  Alternatively a new program group name can be typed into the 
program group field.  Once the program group has been selected click 
on the ‘Continue’ button.

The DECTSync files will be copied to the destination directory and the 
installer will display an installation progress screen.
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Figure 1-12: DECTSync Installation Progress

When the installation is complete the installer screen will close.  The 
DECTSync program is now ready to be run.

CABLE PINOUTS
BASE STATION PROGRAMMING SERIAL CABLE 
PINOUT 
Standard Null-modem cable with data Send and Receive crossed over. 

Table 1-2: Null-Modem Cable Pinout

PC Connection usually 9 way 
Female D-type connector 

Base station connection 9 way 
Male D type connector 

1 N/C 
2 3 
3 2 
4 N/C 
5 5 
6 N/C 
7 N/C 
8 N/C 
9 N/C 
C
A
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BELTPACK PROGRAMMING SERIAL CABLE PINOUT

Table 1-3: Beltpack Programming Serial Cable Pinout

PC Connection usually 9 way 
Female D-type connector 

Beltpack connection 3.5mm Stereo 
jack plug 

1 N/C 
2 Tip 
3 Ring 
4 N/C 
5 Screen 
6 N/C 
7 N/C 
8 N/C 
9 N/C 
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LIMITED WARRANTY
This document details the Clear-Com Standard Limited Warranty for all new products for sale within all 
regions with the exception of Military, Aerospace, and Government (MAG).  

EXCEPT AS SET FORTH HEREIN ("LIMITED WARRANTY"), CLEAR-COM MAKES NO OTHER 
WARRANTIES, EXPRESS, IMPLIED OR STATUTORY, INCLUDING WITHOUT LIMITATION ANY 
WARRANTIES OF MERCHANTABILITY, NONINFRINGEMENT OF THIRD PARTY RIGHTS, OR 
FITNESS FOR A PARTICULAR PURPOSE, ALL OF WHICH ARE EXPRESSLY DISCLAIMED.

1. Standard Limited Warranty.  Clear-Com Communication Systems ("Clear-Com") warrants its 
products, including supplied accessories, against defects in material or workmanship for the time 
periods as set forth below provided it was purchased from an authorized Clear-Com dealer or 
distributor.  

a) Pursuant to this Limited Warranty, Clear-Com will, at its option:

i) repair the product using new or refurbished parts, or;

ii) replace the product with a new or refurbished product.

b) Remedies: In the event of a defect, the rights detailed in 1 (a) are your exclusive remedies.  For 
purposes of this Limited Warranty, "refurbished" means a product or part that has been returned 
to its original specifications.

c) Standard Warranty Period (by Product):

i) All Clear-Com brand systems and products, including belt packs, have a Limited Warranty 
of two years, with the exception of;

(1) Cables, accessories, components & consumable items have a Limited Warranty of 90 
days.

(2) Any Clear-Com product that has been classified as obsolete at the time of sale has a 
Limited Warranty of 90 days from sales and will be replaced with the same product or a 
sales credit will be issued, at the sole discretion of Clear-Com.

(3) Headsets, handsets, microphones, and associated spare parts, as well as UHF wireless 
IFB products, have a Limited Warranty of one year.

(4) UHF WBS Analog wireless intercom systems have a Limited Warranty of three years.
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(5) All software products, including Concert (Client and Server), ECS, Production Maestro 
and Logic Maestro are warranted for one year and shall substantially conform to 
published specifications.  The media on which the Software is furnished is warranted to 
be free of defects in material and workmanship (under normal use) for a period of one 
year.

(6) Any Clear-Com products that are listed within the last time buy period have the same 
Limited Warranty for their type 1.i 1 - 1.i.5 as above.

d) Any Clear-Com product that is repaired or supplied as a replacement under the terms of this 
Limited Warranty shall inherit the remaining warranty period from the original product.

e) Standard Warranty Period Start Date

i) Dealer / Distributor Sales:  In view of Dealer or Distributor stocking practices, the Standard 
Warranty Period for products sold through Dealers or Distributors will commence from the 
Clear-Com invoice date and will include an automatic extension of three months.  Any valid 
warranty claim within the Standard Warranty Period as determined by the Clear-Com 
invoice date will be covered without further supporting evidence.  All warranty claims after 
this date must be supported by the Customer's proof of purchase that demonstrates the 
product is still within the Standard Warranty Period (as detailed in Section 1.c.i above, plus 
the automatic three month extension) from their purchase date.

ii) Direct Sales:  The Standard Warranty Period will commence from the date the product was 
shipped from Clear-Com to the Customer.  The Standard Warranty Period start date for 
contracts that include commissioning will be the date of the Site Acceptance Test (SAT) or 
one month from conclusion of the commissioning project, whichever is earlier.

f) Invalidation of Warranty

i) This Limited Warranty shall be invalidated if the product's outer case has been opened and 
internal modifications have been made or damage has occurred, or upon the occurrence of 
other damage or failure not attributable to normal wear and tear.  Authorized modifications 
with Clear-Com's express written permission will not invalidate the warranty.

g) Software Updates 

i) Software Updates are released periodically to correct discovered program bugs.  During the 
Warranty Period, software updates are available to Customers free of charge.
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h) Software Upgrades 

i) Software Upgrades include new Features and/or Functional Enhancements and are not 
included as part of the Standard Warranty but may be purchased at the published rates.

ii) Note:  In the absence of a Software Update containing a program correction and no 
available workaround to mitigate the problem, at the discretion of Service, Sales, 
Engineering, or Product Management, the Customer may be provided a Software Upgrade 
under warranty.

2. Exclusions.  Services do not cover damage or failure caused by any occurrence beyond Clear-Com's 
reasonable control, including without limitation acts of God, fire, flooding, earthquake, lightning, failure 
of electric power or air conditioning, neglect, misuse, improper operation, war, government 
regulations, supply shortages, riots, sabotage, terrorism, unauthorized modifications or repair, strikes, 
labor disputes or any product failure that Clear-Com determines is not a result of failure in the 
Services provided by Clear-Com. Further Services excluded from this Agreement include: services 
required due to errors or omissions in Customer purchase orders; installation or maintenance of 
wiring, circuits, electrical conduits or devices external to the products; replacement or reconditioning 
of products which, in Clear-Com's opinion cannot be reliably maintained or properly serviced due to 
excessive wear or deterioration; Customer's failure to maintain the installation site in accordance with 
the environmental specifications of the products; or service on products removed from the location 
originally specified by Customer and/or reinstalled without the prior written approval of Clear-Com. 
Customer will pay Clear-Com's then current published charges to restore such Covered Products to a 
condition eligible for further service under this Agreement. Clear-Com shall be excused from and shall 
not be liable for any failure or delay in performance under this Agreement due to the foregoing or any 
causes beyond its reasonable control.

3. Limitation of Liability.  IN NO EVENT WILL CLEAR-COM BE LIABLE UNDER THIS AGREEMENT 
FOR ANY INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES (INCLUDING 
WITHOUT LIMITATION LOST PROFITS), REGARDLESS OF THE FORM OF ACTION, EVEN IF 
ADVISED IN ADVANCE OF THE POSSIBILITY OF SUCH DAMAGES.

4. Assignment.  Neither party may assign this Agreement or any portion thereof without the prior written 
consent of the other, except in the event of a merger, sale of all or substantially all of the assets or 
other corporate reorganization.

5. Ownership of replaced parts or product. All replaced parts or products become the property of 
Clear-Com.  

6. Entire Agreement.  This Agreement constitutes the entire agreement between the parties with 
respect to the subject matter hereof, and supersedes all prior or contemporaneous proposals, oral or 
written, and all other communications between them relating to the subject matter of this Agreement.
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TECHNICAL SUPPORT & REPAIR POLICY

NOVEMBER 1, 2008
In order to ensure that your experience with Clear-Com and our World Class products is as beneficial, 
effective and efficient as possible, we would like to define the policies and share some "best practices" 
that can accelerate any problem solving processes which we may find necessary and to enhance your 
customer service experience.  Our Technical Support, Return Material Authorization, and Repair Policies 
are set forth below.  These Policies are subject to revision and constantly evolve in order to address our 
Customers' and the Market's needs.  Accordingly these are provided by way of guidance and for 
information only and may be changed at anytime with or without Notice.

TECHNICAL SUPPORT POLICY

a) Telephone, online, and e-mail technical support will be provided by the Customer Service Center 
free of charge during the Warranty Period.

b) Technical support will be provided free of charge for all software products under the following 
conditions:

i) The application, operating, and embedded software is installed on a product covered by 
Clear-Com's Limited Warranty, and:

(1) The software is at the current release level; or, 

(2) The software is one (1) version removed from current.

ii) Older versions of software will receive "best-effort" support, but will not be updated to 
correct reported bugs or add requested functionality. 

c) For Technical Support: 

i) North and South America, (inc. Canada, Mexico, and the Caribbean) & US Military:
Hours: 0800 - 1700 Pacific Time
Days: Monday - Friday
Tel: +1 510 337 6600
Email: CustomerServicesUS@vitecgroup.com

ii) Europe, the Middle East and Africa:
Hours: 0800 - midnight Central European Time
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Days: Monday - Friday
Tel: +49 40 853 999 700
Email: TechnicalSupportEMEA@vitecgroup.com

iii) Asia-Pacific:
Hours: 0800 - 1700 Pacific Time
Days: Monday - Friday
Tel: +1 510 337 6600
Email: CustomerServicesAPAC@vitecgroup.com 

d) Email Technical Support is available for all Clear-Com branded products free of charge for the life 
of the product, or two years after a product has been classified as obsolete, whichever comes 
first.

e) Support for Distributor and Dealer Sales 

i) Distributors and Dealers may utilize the Customer Service Centers once a system has been 
installed and commissioned.  Clear-Com Systems and Applications Engineers will provide 
support to the Distributor from the pre-sales stage through to satisfactory installation for new 
system purchases.  Customers will be encouraged to contact their Dealer or Distributor with 
their installation and technical support enquires rather than using the Customer Service 
Centers directly.

f) Support for Direct Sales  

i) Customers may utilize the Customer Service Centers once a system has been installed and 
commissioned by Clear-Com Systems and Applications Engineers, or in the case of project 
installations, once the Project Team has completed the hand-over to the Support Centers.

RETURN MATERIAL AUTHORIZATION POLICY

a) Authorizations: All products returned to Clear-Com or a Clear-Com Authorized Service Partner 
must be identified by a Return Material Authorization (RMA) number.

b) The Customer will be provided with an RMA number upon contacting Clear-Com Sales Support 
as instructed below.

  
c) The RMA number must be obtained from Clear-Com via phone or email prior to returning product 

to the Service Center.  Product received by the Service Center without a proper RMA number is 
subject to return to the Customer at the Customer's expense.
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d) Damaged equipment will be repaired at the Customer's expense.

e) Returns are subject to a 15% restocking fee.

f) Advance Warranty Replacements (AWRs);

i) During the first 30 days of the Standard Warranty Period: Once the equipment fault has 
been verified by Clear-Com or its authorized representative, Clear-Com will ship a new 
replacement product.  The Customer will be provided with an RMA number and be required 
to return the faulty equipment within 14 days of receipt of the replacement or will be invoiced 
for the list price of a new product. 

ii) During days 31-90 of the Standard Warranty Period:  Once the equipment fault has been 
verified by Clear-Com or its authorized representative, Clear-Com will ship a like-new, fully 
refurbished replacement product.  The Customer will be provided with an RMA number and 
be required to return the faulty equipment within 14 days of receipt of the replacement or will 
be invoiced for the list price of a new product.

iii) To obtain an RMA number or request an AWR:

(1) North and South America, Asia-Pacific, and US Military:
Hours: 0800 - 1700 Pacific Time
Days: Monday - Friday
Tel: +1 510 337 6600
Email: SalesSupportUS@vitecgroup.com

(2) Europe, the Middle East and Africa:
Hours: 0800 - 1700 GMT + 1
Days: Monday - Friday
Tel: + 44 1223 815000
Email: SalesSupportEMEA@vitecgroup.com

iv) Note: AWRs are not available for UHF WBS Analog wireless intercom systems.  UHF WBS 
Analog wireless intercom systems out-of-box failures must be returned to Alameda for 
repair. 

v) Note: Out-of-box failures returned after 90 days will be repaired and not replaced unless 
approved by Clear-Com Management.

vi) Note: AWRs are not available after 90 days of receipt of product unless an AWR Warranty 
Extension is purchased at the time of product purchase.
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vii) Note: Shipping charges, including duties, taxes, and insurance (optional), to Clear-Com's 
factory is the responsibility of the Customer.  Shipping AWRs from Clear-Com is at 
Clear-Com's expense (normal ground or international economy delivery).  Requests for 
expedited shipping (E.g. "Next-Day Air") and insurance are the responsibility of the 
Customer.

REPAIR POLICY
a) Repair Authorizations: All products sent to Clear-Com or a Clear-Com Authorized Service Partner 

for repair must be identified by a Repair Authorization (RA) number (see above).

b) The Customer will be provided with an RA number upon contacting Clear-Com Customer 
Services as instructed below.

c) The RA number must be obtained from Clear-Com via phone or email prior to returning product to 
the Service Center.  Product received by the Service Center without a proper RA number is 
subject to return to the Customer at the Customer's expense.

d) Return for Repair 

i) Customers are required to ship equipment at their own cost (including transportation, 
packing, transit, insurance, taxes and duties) to Clear-Com's designated location for repair.  

(1) Clear-Com will pay for the equipment to be returned to the Customer when it is repaired 
under warranty.

(2) Shipping from Clear-Com is normal ground delivery or international economy.  
Requests for expedited shipping (E.g. "Next-Day Air") and insurance are the 
responsibility of the Customer.

ii) Clear-Com does not provide temporary replacement equipment ("loaner") during the 
period the product is at the factory for repair.  Customers should consider a potential 
prolonged outage during the repair cycle, and if required for continuous operations 
purchase minimum spare equipment required or purchase an AWR Warranty Extension.

iii) No individual parts or subassemblies will be provided under warranty, and warranty repairs 
will be completed only by Clear-Com or its Authorized Service Partners.

iv) Customers requesting a non-warranty repair will be provided an estimate of the total repair 
cost prior to the return of the equipment.  In the event that Clear-Com is unable to estimate 
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the cost of repair, the Customer may elect to return the product to the factory for an 
estimate.  The Customer is responsible for shipping costs both to and from the factory in the 
event they choose not to accept the estimate.

v) The Customer must provide either a purchase order for the repair work, or will be required 
to make an advance payment (as a debit against the Dealer's line of credit, or credit card) 
prior to the repaired product being returned to the Customer.

vi) For requesting a Repair Authorization number:

(1) North and South America, Asia-Pacific, and US Military:
Hours: 0800 - 1700 Pacific Time
Days: Monday - Friday
Tel: +1 510 337 6600
Email: CustomerServicesUS@vitecgroup.com

(2) Europe, the Middle East and Africa:
Hours: 0800 - midnight Central European Time
Days: Monday - Friday
Tel: +49 40 853 999 700
Email: TechnicalSupportEMEA@vitecgroup.com

vii) Note: Clear-Com's Limited Warranty does not cover normal wear and tear.  The Customer 
will be charged the full cost of the repair if their equipment has been tampered with by 
non-approved personnel, or has been subject to damage through electrical failure, liquid 
damage or mishandling.  The Customer Service Center will provide the Customer with a 
cost estimate for any such repairs prior to undertaking the work.
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	Software License
	a. These terms supersede all prior agreements representations and understandings between you the Customer and VGC and their auth...
	b. No variation to these terms, nor any other terms or conditions proposed by you, shall be of any effect unless recorded in a w...
	c. You confirm that you are not relying on any statement made by or on behalf of VGC, other than statements recorded in a written document signed by VGC.
	d. VGC and its licensors reserve all rights not expressly granted to you. VGC's licensors are intended third party beneficiaries of this Agreement and have the express right to rely upon and directly enforce the terms set forth herein.
	e. You agree that the Software belongs to VGC and its licensors. You agree that you neither own nor hereby acquire any claim or ...
	a. The copyright and all other rights in the Software produced by VGC shall remain with VGC or its suppliers. You must reproduce any copyright or other notice marked on the Software on any copies that you make.
	a. Use the Software only at a single site location. If you wish to use the Software at more than one site you must contact VGC and if required purchase further Licenses;
	b. Make one copy of the Software for archival or back-up purposes, and;
	c. Transfer the Software to an end user of a VGC product, only if you have made it clear to VGC that you are not the end user and you assign all of your rights under this License and make no use of the Software yourself.
	a. Use the Software or make copies of it except as permitted in this License;
	b. Publish or distribute the computer images, sound files or fonts included with the Software as computer images, sound files or fonts;
	c. Translate, reverse engineer, decompile or disassemble the Software, except to the extent the foregoing restriction is expressly prohibited by applicable law;
	d. Rent, lease, assign or transfer the Software except as set out above; or
	e. Modify the Software or merge all or any part of the Software in another program.
	a. This License shall continue for as long as you use the Software. However, it will terminate if you fail to comply with any of...
	a. VGC warrants that the storage media in this Software will be free from defects in materials and workmanship for 90 days from ...
	b. After the initial 90 days, THE SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND EITHER EXPRESS, IMPLIED OR STATUTORY...
	a. For the avoidance of doubt, all conditions imposed by law covering matters such as fitness for purpose, compliance to descrip...
	b. IN NO EVENT SHALL VGC BE LIABLE FOR ANY LOSS OF PROFITS, LOSS OF BUSINESS, LOSS OF DATA OR USE OF DATA, INTERRUPTION OF BUSIN...
	c. The warranty is personal to you (or end user if you have made it clear that you are not the end user) and may not be transferred (except as permitted expressly above).
	d. VGC shall not be a liable for failure to perform any obligation to you where such failure is due to circumstances beyond VGC’s reasonable control.
	e. VGC offers extended warranties and, if you are not satisfied with the above, you should consider such warranties or consider separate insurance.
	a. Any failure by VGC to insist on its strict rights under this Agreement shall not be deemed to be a waiver of those (or any other rights) and only a duly executed written release shall constitute such a waiver.
	b. If any of these conditions is deemed invalid or unenforceable the remainder shall be unaffected.
	c. VGC's dealings with you shall be governed by English law if you are resident in the EMEA region and California law if you are...
	d. If any document is written in more than one language the English text shall prevail.
	e. Capitalized terms not defined herein shall have the meanings set forth in Vitec Group Communications' Terms and Conditions, as amended from time to time.
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